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iManage DeskSite User Reference Manual

vary, because this dialog can be customized by your system administrator. Table
4.1 provides a list of the many possible fields that may be used to search for doc-
uments in your database,

To search for documents according to profile information:

1. If iManage DeskSite is not running, lJaunch iManage DeskSite and log into
the WorkSite Middle Tier Server. If you are working from within an applica-
tion that is integrated with iManage DeskSite, select Open from the File
pulldown menu in your application to display the Manage Integrated Desk-
top.

2. Display the Search Dialog window by clicking on the Search icon or by
selecting Search from the Search pulldown menu in iManage DeskSite.

3. Enter search criteria in the fields of profile information displayed in the
Search Dialog window. When you click on the Find button, iManage
DeskSite will locate documents whose profile records match the information
entered in the Search Dialog window.

Note: If Lookup buttons are available in your Search Dialog window, these are
an easy and quick way to enter search criteria into search fields. Click on the
Lookup buttons to select valid entries from a lookup table.

Click on Find to display the search results in the Document Grid. iManage
PeskSite will display up to the maximum number of documents. You can change
the maximum number of documents that will be displayed in the Document Grid
as the result of & search by seleciing Setup Display Options from the
Options menu.

Table 4.1: Fields of Profile Information that may be searchable in your database

Number The document number is a unigue number automatically assigned by
iManage DeskSite
Version Version number of the document (1-999)
Description Long name of document, up to 254 characters
Name Short name of document, up to 16 characters
100
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Table 4.1: Ficlds of Profile Information that may be searchable in your database

Format Type

This field indicates which application should be used to open the docu-

ment. In most cases, this field is automatically set when the document is
added to the database

Author Author of the document

Operator The Operator is another user, who like the author, has read/write access to
the document, its profile information, and can set document access rights

Class A classification used to help identify the document

Client Another custom classification field. This field determines the valid entries
for the Matter field

Matter Another customn classification field used to identify and classify the docu-

ment. The list of valid entries for this field depends on the entry in the Cli-
ent field. (In effect, this field can be conceived of as a subclagsification)

Custom Fields

Other custom fields may appear in the profile information for documents
in your database. These fields may be additional fields used to classify the
document, or numeric entry fields, checkboxes, or date entry fields.

Creation Date | Date document was created or installed

Last Edit Date | Most recent date when document was edited

Last EditTime | Most recent time when document was edited

Last User Name of the user who most recently edited the document.

Size Size of the docurnent in number of bytes

Retain Days This is the number of days that the document can remain inactive in the
database before iManage DeskSite tags it for archiving,.

Index Flag Indicates whether the document should be indexed by the full text indexer

Comment Comment associated with the document, up to 8,000 characters, fully

searchable

A Sample Profile Search

Profile searches are performed by entering information info the profile fields in
the Document Search window. Documents are found that have profile fields that
match the search information specified. This type of search is sometimes called a
query-by-form search. In the example below, an Author name and Document
Type are specified. For documents to match the search criteria, BOTH fields of
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profile information must match the entries in the Document Search window.

X 5/23/199

Figure 4.6: Sample Document Search window

The documents retumed from this search must have CLIFF in their Author field i
and WINWORD in the Document Type field. ' |

A More Detailed Search

If you find that your search results include too many documents, you need to
restrict the scope of your searches further. You can restrict the scope of your
search and usually decrease the number of hits by adding more criteria to the
search profile. Below is an example of a more detailed profile search. Fields that i
contain no information always match.
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eument Search

Figure 4.7: A more detailed search

Notice the differences between the search performed in Figure 4.6 and the search
performed in Figure 4.7. In Figure 4.7, three Authors are specified, a Client is
Multiple Entries in the Same Field

When you specify multiple valid entries in the same field of profile information,
such as in Figure 4.7, where AMARTINEZ, APHILIPS and BOWEN are all
specified in the Author field, iManage DeskSite will return documents in the
search results that match ANY of these entries. This is different from when you
specify entries in multiple fields of profile information. In Figure 4.6, for
instance, in which information was specified in the Type and Autheor fields,
iManage DeskSite would only retumm documents whose profile information
maiched BOTH of these fields. When you include multiple entries in a single
field of profile information, IManage DeskSite will return documents that include
at least one of these entries in that field of profile information. Hence, after the
search shown in Figure 4,7 is performed, all of the documents found will contain
WINWORDG in the Type field AND MONTAGE in the Client field AND either
AMARTINEZ, APHILIPS or BOWEN in the Author field. The documents
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retumed will also have a Create date after 12/01/98.

Note: When multiple entries are provided in a single search field, use commas
to separate each entry.

Wildcard Characters

In addition to being able to select validated entries from selection lookup tables,
you can also use wildeard characters to expand and simplify searches. Wildcard
characters allow you to match only parts of entries in document profile fields.
There are two principal wildcard characters: the asterisk and the question mark.

«  The asterisk or percent sign stands for any sequence of multiple characters

+  The question mark stands for any single character

An Example

Let’s say that you want to search for all of the documents pertaining to a particu-
lar client, called The Montage Company. However, because there are so many
documents in the database pertaining to this client, multiple Client classifications
were created. Some of these are:

+ MONTAGE

« MONTAGE CO

*»  MONTAGE EST
+  MONTAGE MFG

You could enter all of these in the Client field in the Search Dialog window to
petform a search that would find all of the documents that include any one of
these entries in the Client field of profile information. You could also do the same
thing by entering

QMUNTAGE*

in the Search Dialog window. MONTAGE* or MONTAGE?%, will instruct
iManage DeskSite to match any entries that begin with MONTAGE and that are
following by any string of characters.
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If the library also including documents pertaining to The Montage Company that
were classified with the Client classification THE MONTAGE COMPANY, you
could include these documents in your search results by adding an asterisk or
percent sign to the front of the entry in the Client ficld, namely:

{"MONTAGE*

The Question Mark

The question mark is used to match any single unspecified character. If you
wanted to match Client field entries of the type:

- MONTAGEL
+  MONTAGE2
+  MONTAGE3

+  MONTAGE4

You could use MONTAGE? in the Client fleld in the Search window.

Caveat

The danger in using wildcard characters is that you will increase your search
results by including undesired matches. For instance, you could match all of the
example Client classifications mentioned earlier that pertain to our fictional
example, The Montage Company, using this entry in the Client field:

However, this entry would also match such possible Client entries as:

= MONTHLY REPORTS
- *  MONTGOMERY CO
= MONTSOON FLOWERS CORFP

Wildcard Characters in the Description Field

Wildeard characters can be particularly useful in searching the Description field.
By default, iManage DeskSite automatically inserts wildcard asterisks as shown.,
This finds all documents that have the terms WINSOR TRUST in the Descrip-
tion field:
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You can change the default in the Advanced Options dialog box explained in
Chapter 6. If you did not include the leading asterisk, iManage DeskSite would
only find documents whose Description field began with WINSOR TRUST. On
the other hand, if you omitted the ending asterisk, iManage DeskSite would only
find documents whose Descriptien field ended with the terms WINSOR TRUST.

Searching by Document Numbers

One of the most direct ways to locate documents in the database is to search for
specific document numbers. If you know the document number for a document,
this can be an effective way of locating the document quickly, because every doc-
ument in the database has a distinct document number and version number.

Numbers can be entered in the Number and Version fields in the Search Diclog
window either as single numbers or as ranges. The following search would find
documents with the numbers 1, 10 to 20, and 100 to 110 (if they exist), and
would retumn only versions 1 io 3 of these documents (if those versions exist).

.10-20,100-110

Figure 4.8: Partial screen shot of the Search Dialog window.

You can also use the less than (<) and greater than (>) symbols to find a range of
document numbers.

Using Lookup Dialog Boxes

106

The fastest and most accurate way to enter search criteria in the Search Dialog
window is to select entries from Lookup dialog boxes. Lookup dialog boxes list
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valid search entries for each field of profile information. If the field of profiie
mformation that you would like to use to search the database has a browse button
next to if, clicking on the browse button will display a Selection dialog box and a
list of valid entries from which you can choose.

Below 1s an example Selection dialog box where you can select or look up values
for the Type profile field.

AMSI
WISIO
HH
HTML
HLPMISE
JPEG
TIFF
‘WPFS0
WPFE0
WEFS1
WPFE1
[QuattroPro for Windows B/7/8 QUATH...
Excel 5.0 EXCELS
Presentations Slide Show 7/8 PRSHwW i
IS Excel 97 EXCELSY [

Figure 4.9; Selection dialog box for Type entries in a sample database.
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Note: The Lookup dialog boxes only displays up to the first 500 valid entries
listed for that field of profile information in the database. If there are more than
500 possible valid entries, use the Find option at the top of the Selection dialog
box to locate your entry. When you enter a vahue in the Find field at the top of the
Selection dialog box, iManage DeskSite searches the entire list of valid entries
for matches — not just those listed in the Selection dialog box.

The Lookup Feature in all Selection Dialogs

108

Use the Lookup feature at the top of all Lookup dialog boxes to locate valid
entries in especially long lists. When you enter search criteria in the Lookup
field, the table of available options immediately highlights the first match. Click
the Look Up button and the table displays only those options that match.
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WordPerfect 5.1/5.2
WordPerfect 6/7/8

Figure 4.10: Selection dialog box after search was performed for the string
"WordPerfect"

Selecting Multiple Entries

Figure 4.10 also shows that you can select multiple entries in the Selection dialog
box before clicking the OK button. When you click OK, all selected entries
appear in the appropriate field in the Search Dialog window.

Double-clicking an entry in a Selection dialog box selects the entry and returns
you to the Search Dialog window.
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Full Text Searches

Overview

iManage DeskSite’s full text searches find documents based on the occurrence of
individual words, partial words, and phrases, referred to collectively as ferms.
You can search for occurrences of terms either in the contents of documents or in
the text of profile comment fields. You can also perform a search of documents
that are within multiple libraries at once.

Full text searches can be performed in conjunction with profile searches. The
documents that are found must meet the profile search criteria and contain the
words or phrases specified by the full text search.

By default, full text searches are not case sensitive.
Entering Full Text Search Criteria

You can enter full text search criteria at the bottom of the Search Dialog window.
You can also select whether to search through the entire body of the document or
the comments field of profile information by clicking the Documents or Com-
ments radio buttons. In the example below, the user is searching for occurrences
of the word “car” or “cars” in the full text of documents that were writien by
CLIFF and are of the type WINWORD2:
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m:ulnent Search

Enter full text
search queries

Click here for the
simplified full text
search query dialog
creation window.

Figure 4.11: Document Search dialog

Simplified Full Text Searching

Select whether to search the
full text of documents or the
Comments field of profile
information.

A simplified full text search window is available for users who are not familiar
with Boolean logic or who do not want to [earn how to construct full text search
commands. This dialog box enables you to enter key terms or phrases and to con-
struct a simple full text search query automatically.

To access the simplified full text search window:

Click on the browse button next to the Index field, which is used to enter full text
search queries. When you click this browse button, the Find Documents Contain-
ing dialog box appears:

AUTOb20111
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Find Documents Containing

Figure 4.12: Simplified full text search dialog box

Using the Find Document Containing Dialog Box:

I12

You can use the intaitive Find Documents Coniaining dialog box to create simple
full text search queries automatically. When the Find Documents Containing dia-
log box appears, enter words or phrases separated by commas into the appropri-
ate fields. In the topmost field, enter a list of terms which must ALL appear in the
document in order for it to appear in your search results.

The drop-down list box available above this field lets you set the proximity with
which these terms must appear near each other. If you select Anywhere in docu-
ment, then iManage DeskSite will return documents in which these terms appear
anywhere in the document, not necessary within any proximity of each other.

If you select Near each other from the drop down list box, then the words listed
in the topmost field must appear within a defined proximity of each other in 2
document for that document to be listed in the search results. The Near field indi-
cates the proximity within which the words in the topmost field must appear in
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the document in mumnbers of words. If the Near field is set to 10 and two words
are listed in the All of these words ficld, then these words must both appear in a
document and cannot be separated by more than ¢ words for iManage DeskSite
to list the document in the search results.

In the middle field, enter a list of terms only one of which must appear in the doc-
ument for it to appear in your list of search results.

In the boitom field, enter terms that should exclude a document from the search
results if they appear in that document.

Examples

The example in Figure 4.11 finds documents that include both the phrase New
England and the phrase North Dakota. It does not return documents that contain
the word New and the word England in separate places — these words must be
next to each other and in that order. The same applies to the two terms in the
phrase, North Dakota.

Error Checking

When you click OK in the Find Documents Containing dialog box, iManage
DeskSite checks the syntax of the terms you have enfered and reports any error
that you may have entered. If no errors are found, IManage DeskSite constructs a
valid search query, which appears in the Index field in the Search Dialog win-
dow.

Example with Wildcard Characters

You can also enter wildcard characters in the Firnd Documents Containing dialog
box. Figure 4.12 shows the use of a wildcard character in the Find Document
Containing dialog box with terms entered in the middle field.
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Find Documnts Containing

rollege, universit®, higher education

Figure 4.13: Another example of Find Documents Contairing dialog box

The example search query shown in Figure 4.13 would return documents that
included the term college, or the phrase higher education,or the terms university
and universities. :

Proximity Searches

Figure 4.14 below shows how to enter a proximity search in the Find Documents
Containing dialog box. By “proximity search,” we mean a search based on the
proximity of words in relation to each other in the document, not just on their
occurrence in the document.
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Find Diocuments Containing o

Mear each other

Figure 4.14: Find Documents Containing dialog box with search criteria entered
for a proximity search.

In Figure 4.14, the Near each other option has been selected from the drop-
down list and the Near numeric value has been set to 14. When this search is per-
formed, iManage DeskSite finds only those documents in the database that con-
tain the words client and complaint within 14 words of each other. The two words
car. appear in any order, but they cannot be separated by more than 13 words.

Search Elements

A query expression is the criteria used to perform a full text search. It is com-
prised of several elements, either explicit or implicit: operators, modifiers, and
terms.
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Query Expression

(s.hallots AND mushrooms AND NOT anchovies]

T Maodifier

Term

Operator

Operators

Operators are codes that represent logic to be applied to a search. These are listed
and defined in the following section, Operators. To specify an operator in a
search, type the operator in less than/greater than brackets and then the word or
phrase that you want to find, as in <STEM> facilitate.

Although operators need not be entered in all caps, they appear in this chapter as
such for the sake of clarity.

Modifiers

Modifiers adjust the default meaning of a given operator. For example, the CASE
modifier would make the WORD operator case sensitive. The modifiers are
listed and defined under “Modifiers” on page 124

Simple and Explicit Syntax
You can perform a full text search according to simple or explicif syntax.

Simple Syntax

Simple syntax refers to when you enter just terms with no accompanying codes
or punctuation. iManage DeskSite produces matches as if the terms are preceded
by the STEM operator. Although they are less exact, simple searches pet more
matches than explicit ones.

Explicit Syntax

You can use explicit syntax by enclosing a word in double quotation marks.
When you double-quote a word, iManage DeskSite performs a literal search;
Jacilitator and facilitation would not be offered as matches to “facilitate”.
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Other Syntax Options

Parentheses

Parentheses indicate the order in which the search is to be executed. iManage
DeskSite reads information within parentheses before looking at whatever may
be outside them. For example, suppose you were io enter the following search:

(Homer AND Marge) OR Bart

iManage DeskSite would look for documents that refer to Homer and Marge— 4
not just one or the other. Any documents that referred to Barf also would be
included.

Parentheses can also be placed within each other. The following example means,
“Find documents that contain either Homer or Marge—it doesn’t matter which—
as long as the document also contains Bart. Also, give me any documents that
mention Lisa.”

(Bart AND (Elomer OR Marge)) OR Lisa

Double Quotation Marks to Search for Operator Words

To search for a word that happens to be an operator, such as AND or NOT, put
the word in double quotation marks to indicate that the word should be consid-
ered as such, not as an operator. For example, to search for the phrase Lewis and
Clark, you would enter:

Lewis “and” Clark
Operators

This section lists each of the operators used in full text and profile searches.

Profile Field Operators

Some operators work only in profile fields.

> (Greater Than)

The greater than sign can be used to search for documents that contain a value in
a particular profile field that is greater than a specified miniroum value. For
example, to select documents with a document number greater that 2500, enter
the fellowing criteria in the Documerit Number profile field:
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>2500

>= {Greater Than or Equal To)

The greater than or equal-to sign searches for documents that contain a value in a
particular profile field that is greater than or equal to a specified value. To search
for documents with a document number greater than or equal to 2800, enter the
following eriterfa in the Document Number profile field:

>=2800

< (Less Than)

The less than sign can be used to search for documents that contain a value in a
particular profile field that is less than a specified maximum limit. For example,
to search for documents with a version number less than 3, enter the following
criteria in the Version Number profile field:

<3

<= {Less Than 6r Equal To)

Like the greater than or equal to sign, the less than or equal to sign combines the
searching power of the less than and equal to signs. To search for documents with
a version number less than or equal to 3, enter the following criteria in the Ver-
sion Number profile field:

<=3

Full Text and Comment Operators

118

The following operators work in full text searches of profile comments and full
documents.

<AND>

This Boolean operator finds documents that contain both terms on either side of
it. While the OR operator broadens a search, the AND operator narrows it. Use
AND to connect terms with different meanings. The search query New England
AND North Dakota would find only documents that contain both phrases; if a
document contained only one of the terms, it would not be included in the search
results. Enclosing brackets are optional on the AND operator.
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<NEAR>

The NEAR operator is similar to AND in that only documents that contain both
terms are included in the search results; however, NEAR presents matches that
contain both terms close together. For example, suppose you enter the following
search:

lincoln <NEAR> beard

The search criterion finds docu.rﬁents with the words lincoln and beard near each

other. 4 '

<NEAR/n>

The <NEAR/n> operator is a more specific variety of the NEAR operator in that
you specify the maximum distance allowed between each term. The N variable
can be any whole number between 1 and 1,024 (exclude the comma in numbers
greater than 999), where 1 indicates that the terms are adjacent. For example,
suppose you enter the following criteria:

Jjefferson <NEAR/7> crop

The search criterion finds documents with the words jefferson and crop within

~ seven words of each other.

<0OR>

OR is a Boolean operator that finds documents that contain at least one of the
terms to which it is applied. The OR operator enlarges the search topic and is nor-
mally used to look for terms that have similar meaning or refer to similar sub-
jects. The search criterion lowuis armstrong OR satchmo would find documents
with one or both of the terms. The enclosing brackets are optional on the OR
operator. ' '

<PARAGRAPH>

The <PARAGRAPH> operator searches for documents that include all of the
given search elements within a paragraph. You can specify search elements in a
sequential or random order.

To get documents that contain variations of the word wombat and the phrase ice
cream in the same paragraph, enter:
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120

wombat <PARAGRAPH> ice cream

If you search for more than two words or phrases, you must include the PARA-
GRAPH operator between each word or phrase. For example, suppose you enter
the following criterion:

0ak <PARAGRAPH>maple<PARAGRAPH>ash tree

The search finds all documents that have oak, maple and ash tree in the same
paragraph.
<SENTENCE>

The <SENTENCE™ operator searches for documents that include all of the given
search elements within the same sentence. For example, suppose you enter the
following criterion:

automobile industry <SENTENCE> aftermarket

The search finds all documents that have automobile industry and aftermarket in
the same sentence.

You can specify words in sequential order by using the SENTENCE operator in
conjunction with the ORDER modifier.

<STEM>

The <STEM> operator searches for documents that include variations of the
word you specify, as well as explicit matches. For example, to search for docu-
ments that contain a variation of the word disrill, you would enter the following
criterion:

<STEM> distill

Matching documents would include the terms disiill, distillation, distillery, dis-
tilling, distilled, and distills.

Note: The <STEM> operator is used by default and does not need to be speci- |
fied. To override <STEM>, put the term in double quotation marks. |
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<THESAURUS>

This operator selects documents that contain one or more synonyms of the word
you specify. To locate documents containing synonyms of big, enter the follow-
ing:

<THESAURUS> big
Matching documents include words such as large, vast and extensive.

<TYPO/N>

The TYPOY/N operator performs approximate pattern matching to identify words
that are similar to the query term. You can use this operator to search for docu-
ments that have been scanned using an Optical Character Reader (OCR). Since
the TYPO/N operator must scan the entire index to find potential matching
words, this operator is not practical for use in databases containing over 100,000
documents or in performance-sensitive environments.

If you wish, you can specify a variable (N) to define the maximum number of
errors between the query term and a matched term. This value is called the error
distance. If you do not specify an error distance iManage DeskSite uses 2 as a
default. ‘This means that there can be a maximum of 2 differences between the
query term and the matched term. An error is defined as a character insertion,
deletion or replacement. For example, the following table shows word matches
with an error distance of 1:

<TYPO/1> Mouse H replaces M

<TYPO/1> Agreed Greed A is deleted
<EFYPO/1> Cat Coat 0 is added

The following table shows a word match with an error distance of 3:

<TYPO/3> Sweeping I,mm r.ep.léce e, €, p respec-
tively
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The following table shows a word match with an error distance of 2:

<TYPO/2> Swept

S is deleted and K replaces W;
S is deleted (1 error does not
exceed the maximum error dis-
tance of 2)

Kept; wept -

<TYPO> Swept Kept; wept Same as above since the error
| distance 2 is the default

<WORD>

The <WORD> operator searches for documents that melude a given word. For
example, to search for documents that contain the word carrot, you could enter
<WORD> carrot. The WORD operator is only needed when you want to use a
modifier, such as CASE, as a search term.

<WILDCARD>

Using wildcard symbols lends a great deal of flexibility to full text searches.
Wildeards can be used when searching for word prefixes, roots, suffixes, plurals,
and to find words that have variations in spelling. The wildcard characters recog-
nized by iManage DeskSite are listed in Table 4.2. Use the <WILDCARD?> oper-
ator to indicate when you are using wildcard symbols.

Note: Wildcards usually increase the scope of a full text search and can also
increase the time it takes to complete them. In particular, using a wildcard sym-
bol at the start of a word can greatly increase search time, because every entry in
the index must then be searched.

Table 4.2: Wildcard Symbols used for Full Text Searching

 Symbol:. | Explanatior
The question mark replaces any single alphanumeric character. For example,

” <WILDCARD> b?m would match born, barn, or burn. Similarly, <WILD-

) CARD> ?andy would match candy, dand), or sandy. You can use more than one
question mark within a term; for example, WILDCARD sh?7e could produce
shore and shade as matches.

122
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The asterisk is used to represent any number of alphanumeric characters (includ-
* ing none). For example, WILDCARD *vert* would match convertible,
inverted, vertigo, and covert. When using the asterisk wildcard, try to narrow
the potential scope of the wildcard entry as mnch as possible. For instance, to
find documents about aitomobiles, the criterion WILDCARD auto* finds the
words auto, automobile, and autometive, but it would alse find autobiography,
autocracy, and autograph. A more specific query is <WILDCARD> auto OR
automo*.

Brackets tell iManage DeskSite to find one of any character within the brackets.
I1 For example, <WILDCARD> r[aou]t would match documents that contain rat,
rot, Ot ruf.

When you enclose a caret ("} within brackets, the search excludes the string of
characters to the right of the caret. For example, if you enter WILDCARD
‘["block]head’, the term blockhead is not included in the search results. Note
that you must place the caret before the string of characters you want to exclude,
for example WILDCARD ‘["block]head®, but not WILDCARI ‘[block~head".

When you enclose a hyphen (-) within brackets between two letters, iManage
DeskSite looks for every term within that alphabetical range inclusively. For
example, suppose you were to enter WILDCARD ‘a[a-w]a‘, iManage DeskSite
looks for every matching three-letter term from aaa to awa.

Note: When you use brackets, you must enclose the word that contains charac-
ter string with backquotes (°). The character string cannot confain spaces.

Braces are similar to brackets but let you search for groups of characters, sepa-
{} rated by commas. For example, <WILDCARD?> spill{s,age,ing} would match
documenis that contain spills, spillage, and spilling.

Note: When you use braces, you must enclose the word that contains character
string with backquotes (*). The character group listing cannot contain spaces.

Literal Searches for Wildcard Characters

If you want a wildcard character to be interpreted as text and not as a wildcard,
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Modifiers

124

precede the character with a backslash (V). For example, if you wanted to search
for the term M*A*S*H, you would enter <WILDCARD> m\*a\*s\*h.

Modifiers fine-tune the performance of your chosen operators. For example, you
can use the <CASE> medifier with the <WORD?> operator to make the search
case-sensitive.

<CASE>

The <CASE> modifier makes <WORD> and <WILDCARD> searches case-sen-
sitive. For example, the criterion <CASE> <WORD> President would retrieve
documents that contained the word President; occurrences of president or PRES-
IDENT would be ignored.

<NOT>

Used with the AND and OR operators, NOT tells iManage DeskSite to exclude
documents that contain a given term. For example, to retrieve documents that
contain the words mushrooms and olives but not the word anchovies, you would
enter:

mushrooms <AND> olives <AND> <NOT> anchovies

<ORDER>

The <ORDER> operator matches terms based on the erder In which they appear
in the query expression. This modifier can be used with the NEAR/N operator.

The ORDER modifier must appear in front of the operator name. For example, if
you wanted to search for the word iced followed by the word mocha in the same

phrase, you would enter the following criterion:

iced <ORDER> <PHRASE> mocha
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Overview

The iManage Integrated Application Operation allows a user to perform iManage
functions directly from the application they are using. This integration eliminates
the need to switch to the iManage DeskSite application to perform certain iMan-
age tasks.

iManage DeskSite is actively integrated with most major Windows applications,
including:

*  Microsoft Office 97 and 2000 Novell GroupWise 5.2 or 5.5
»  Corel WordPerfect Suite (8) and «  Microsoft Outlook

WordPerfect Office 2000

+  Watermark Professional *  Any MAPI compliant E-mail

+  Any ODMA-Compliant Applica- + Lexus/Nexus Office Suite 7.x
tion ] {CompareRite, CiteRite, Check-

Rite, FullAuthority)
*  Lotus Notes

In addition, if you are using Microsoft Office 2000, another integration option is
available, called Passive Integration. This is an option that your system adminis-
trator may set, according to the needs of your system.
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What does it mean to be “integrated” with other applications?

Active Integration

When iManage DeskSite is integrated with another application, certain functions
in the other application are slightly changed. The functions usually affected are:
Open, Close, Save, Save As, Insert, Print, and Exit

There are also new commands that exist only in integration mode. They are:
Local Open, Local Save, Versions and Edit Profile.

Passive Integration

When the Passive Integration option is set on systems using Microsoft Office
2000, the iManage Open and iManage Save As menu options become avail-
able.

Non-Integrated Applications

In some cases, an application cannot be integrated with iManage DeskSite. In
those cases, iManage DeskSite’s functions will not be available from within the
application. You can still organize, track, and store your documents using iMan-
age DeskSite. You will need to, however, follow this general procedure to open a
document:

—

Launch iManage DeskSite and log into 2 WorkSite Middle Tier Server.
Search for and find the document that you want to open.
Checkout the document from the database.

Launch the application, if it is not already running.

Yok b

Open the document from within the application.
When you are finished editing or revising the document:

1. Launch or switch focus to iManage DeskSite.

2. Use the Checkin option to copy the revised document back to the database.
Startup

In most cases, when yvou first launch an integrated application, the application
automatically detects whether iMavnage DeskSite is running and launches it if
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necessary. In other cases, the integrated application launches iManage DeskSite
when you select an integrated function from the File pull-down menu.

If iManage DeskSite is running but you are not logged into an iManage server,
iManage tries to log into a WorkSite Middle Tier Server. If Autologin settings are
available, iManage DeskSiie tries to do this automatically. If Autologin settings
are not available, or if iManage DeskSite is running, but you are not logged info a
WorkSite Middle Tier Server, the Register Servers dialog box appears, as shown

in Figure 5.1.

Figure 5.1: Login to iManage Server dialog from an integrated application

1. Type the name of the sexrver in the Enter Server Name field, the click Regis-
ter. The Login dialog box opens.
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Figure 5.2: Login dialog box in an integrated application

2. Select the type of Login that you want to use. See Chapter 3 for more infor-
mation about connecting to the DMS. :

3. {Optional) Complete the UserID and Password fields. You will complete this |
step only if Login that you have selected requires this information. ‘ 3

4. Repeat Steps 1 through 3 for each server you want to use and then click
Close. . - '
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File Menu From within Integrated Applica-
tions

Active Integration

An application’s file menu changes in a number of ways when the application is
integrated with iManage. The figure below displays what the MS-Word 97 File
menu looks like when integrated. Many of the command’s behaviors change and
some new options appear. This section details each of these commands.

Functions

New changed by
menu active inte-
options gration

Figure 5.3: File menu from Microsoft Word 97 while in Active Integration mode
with iManage DeskSite.
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Open:

When an application is integrated with iManage DeskSite, and a user selects the

. Open command in the application, iManage launches the iManage Integrated

Desktop. The next section of this chapter outlines all the functionality of the
iManage Integrated Deskiop.

Local Open:

Save:

Save As:
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The Local Open command exists only if the application is integrated. Selecting
it launches a standard Windows Open dialog box, which you can use to locate
files on your local hard drive or on the network. You can use this option to open a
document that is not in an iManage library.

If the document already exists in iManage DeskSite the Save command simply
replaces the original document. For documents that do not exist in an iManage
DeskSite the Save command launches a New Document Profile dialog to allow
you to enter profile information for the new document.

When you select the Save As menu item from the File menu in an integrated
application the Save As Options dialog box is launched. You now have three
options:

. Save As Dptin

Figure 5.4: The Save As Options dialog box appears when you select Save As
from the File menu in an integrated application.
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»  Save as a new doeument: This launches a New Profile dialog box. Enter the
new document's profile information.

»  Save as a replacement for the original document: This saves the docu-
ment as the same document number and version. It replaces the iManage
DeskSite version. This option is, in effect, the same as selecting Save from
the File menu. If you have read-only access to the document you cannot use
this option. Instead, save the document as a New Document or New Version
of the original document.

+  Save as a new version of an existing document: iManage DeskSite auto-

matically assigns a new version number fo the document and a dialog box
displays to enter the new version's profile information.

If your application is ODMA-compliant, iManage DeskSite remembers the
option you used the last time you performed the Save As command and uses
that option as a default. Hlowever, your system administrator can set a specific
option to use as the default all the time.

If the active document does not exist in iManage DeskSite when you select the
Save As command, then a New Profile dialog opens for you to enter the new
document's profile information. '

Local Save As:

When vou select Local Save As from the File menu in an integrated applica-
tion, a standard Windows Save As dialog displays. Use this dialog box to save
vour file on a local hard drive or other directory available on the network. When
you use the Local Save As option, you are saving the file independently of
iManage DeskSite and any libraries to which you may be connected. If your doc-
uwment ofginated from an iManage database, the Local Save As option does
not automatically update the original copy of the document with any changes you
may have made.

Note: The Local Save As command is a convenient method of making a copy
of a document outside the iManage DeskSite document management system.
Simply open a document that is in an iManage database, then use the Local
Save As command to save a local copy of it. The L ocal Save As option is
equivalent to using the Export function in iManage DeskSite.
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Print:

Note: Local Save As and Local Open may be disabled in selected applica-
tions by vour system administrator.

Printing documents in integrated applications is the same as printing documents
in non-integrated applications. The only difference is that the document’s activity
history in iManage DeskSite is updated to show that the document was printed,
how many pages were printed, and who printed the document. If a document is
printed that does not currently exist in iManage DeskSite, a warning message
may appear.

Edit Profiles:

132

When you select Edit Profile from the File menu in an integrated application,

iManage DeskSite’s standard dialog box for viewing or editing document profile

information appears. Users who have read-only access to a document cannot

change the information displayed in this dialog. Users with read-write access can |
change certain fields, such as the comments. Only the Author and Operator of & *
document have the full authority to change such criteria as the access privileges
to the document.
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% Profils Edit and View -Default - . -

nrollment Form

Figure 5.5: The default appearance of the Profile Edit and View dialog box. Your
system administrator can customize this dialog box.

Close:

You close a docurment in an integrated application the same way you close a doc-
ument in the non-integrated application. Whenever you close a document in an
integrated application, you will be given the option of saving the decument if the
contents have changed since the document was opened. Figure 5.6 shows an
example of the message box that you will receive when you close a document in
an integrated application.
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Figure 5.6: Example of the message box that appears when you close a docu-
ment in an integrated application.

If you select Yes from this message box, iManage DeskSite responds as if you
selected Save from the File menu. If the document is not already in an iManage
database, you are prompted to enter profile information for the new document.

Passive Integration

If you are ranning Microsoft Cffice 2000 applications, your system administrator
may set up passive integration. Most menu opiions remain the same as with
Active Integration. There are a few differences.

For more information about using infoLook with Microsoft Office 2000 applica-
tions, see the iManage Office 2000 Integration Module Installation and User s
Reference Manual.
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U ChlN

Functions
New changed by
menu passive inte-
. gration
options
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[& Print Preyiew

BB Edit Profile.

R R

Figure 5.7: File menu from Microsoft Word 2000 while passively integrated
with iManage DeskSite .

Open

The Open command launches a standard Windows Open dialog box, which you
can use to locate files on your local hard drive or on the network. You can use this
option to open a document that is not in an iManage library.

iManage Open

‘When an application is passively integrated with iManage DeskSite, and a user
selects the iManage Open command in the application, iManage launches the
iManage Integrated Desktop, explained in detail in th next section.
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Save As

When you select Save As from the File menu in a passively integrated applica-
tion, a standard Windows Save As dialog opens. Use this dialog box to save your
file on a local hard drive or other directory available on the network. When you
use the Local Save As option, you are saving the file independently of iMan-
age DeskSite and any libraries to which you may be connected. If your document
originated from an iManage database, the Save As option does not automati-
cally update the original copy of the document with any changes you may have
made.

iManage Save As
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When vou select the iNManage Save As menu item from the File menu in a
passively integrated application the Save As Options dialog box launches. You
have three options:

Save As Options

Figure 5.8: Save As Options dialog box for Microsoft Office 2000 applications

+  Save as a new document: You may select the Save As Type by selecting
from the drop down list. The list is the same as the list you would see in the
Microsoft Office 2000 application you are using. When you click OK, a New
Profile dialog box launches. Enter the new document's profile information.

»  Save as 2 replacement for the original document: This saves the docu-
ment as the same document number and version. It replaces the iManage
DeskSite version. This option is, in effect, the same as selecting Save from
the File menu. If you have read-only access to the document you cannot use
this option. Instead, save the document as a New Document or New Version

AUT0020136



Chapter 5: Integrated Application Operation

of the original document. This option does not allow you to select the Save
As Type from the drop down list.

Save as a new version of an existing document: iManage DeskSite auto-
matically assigns a new version number to the document and a dialog box
displays to enter the new version's profile information. This option does not
allow you to select the Save As Type from the drop down list.
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iManage Integrated Desktop

As has been detailed earlier in this chapter, iManage documents can be accessed
directly through an Integrated Application. The Integrated Desktop is the dialog
that appears instead of the standard Windows dialogs that normally appear in
non-integrated applications.

tool9 NAT.. - PA.. BA5/01.
%]HR  1020200_1 .. LE.. BA&DO1.

notify jiacd |
ane more '

- Public Pages

Personal

Public: Saved ;
% Public 5aved |

Figure 5.9: Integrated Deskiop Main Window
Integrated Desktop: Main Window

Tree Frame:

On the left side of the Integrated Desktop is the Tree Frame. It contains the orga-
nizational structure of all servers, libraries, iManage WorkSite pages if any, fold-
ers, worklists and saved searches. Clicking a page icon displays the folders listzd
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on an iManage WorkSite page. Clicking a folder icon displays the contents of
that folder in the Document List.

Pages

If Pages were created in the iManage WorkSite application, you can see the page
structure in iManage DeskSite. You can access documents from folders on these
pages and perform all activities on them that you can perform to documents in
other folders. The activities you can perform depend on your Role and the access
rights you have to the Pages and Folders. You cannot create Pages in the iManage
DeskSite application.

Folders

Libraries contain folders, which are static groups of documents you can create or
share with other users. Folders provide a method for organizing and sharing doc-
uments easily. To display the contents of a folder, click the icon for that folder
and the documents within it appear in the Document Grid.

Document List:

All the documents of a highlighted folder in the Tree Frame are displayed in this
Document List view. You can organize the list in Ascending or Descending order
by clicking the column heading.

You can also narrow the focus of documents in the Document List by using the
Document Number and Document Version pull-down menus in the Filter Condi-

tions section at the bottom of the window.

To configure which columns appear in this Document List, click

The Document List Column Selection dialog launches,

Shortcut Bars:
The Browse Bar contains the Folder Tree to Jocate any document on the server i
you are logged on to. A user can create Shortcut bars beneath the Browse Bar to :
keep folders. The iManage Shortcut Bar exists as a default and can not be
deleted.

To Create a Shortcut Bar:
1. Right-mouse click on the iManage Shortcut Bar.

2. Select Add Group from the pop-up menu.
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3. Name the new group in the space provided.

4. Click on any other Shortcut Bar.

To Delete a Shortcut Bar;
1. Right click once on the Shorteut Bar you wish to delete.

2. Select Remove Group from the pop-up menu.

To Insert Folders into your Shortcut Bar:

1. Inthe Folder Tree, right-mouse click on the folder vou would like to addto a
shortcut bar.

2. Inthe menu displayed, select Add to Shortcutbar.

3. ‘Select the specific Shortcut Bar where you wish to insert the folder.
Integrated Desktop: Searching for Documents

New Search

Click Search at the top of the Integrated Desktop Window to perform a standard
iManage search. The Search dialog form is customizable so the options available
on the form vary. The Document Search dialog is designed in the iManage Dialog
Editor application that is usually not accessible by anyone but the System
Administrator. For detailed information on searches, see Chapter 4: Searching

for Documents.

Navigation Buttons

Forward

Click Forward to navigate to a folder lower in the tree structure that you looked
at previously and then moved back from.

Back
Click Back to navigate to a folder higher in the tree structure.

Integrated Desktop: Document Commands

Open, Insert, Insert Link, etc |
The user launches the Integrated Desktop most often because he or she simply
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wants fo access a document in iManage. If you reach the Integrated Desktop by
clicking Open from an application’s File menu then you most likely just want to
open the document in the application. To do this, double-click the document. If
you reach the Integrated Desktop by clicking Insert File or Insert Link from an
application, navigate to the document and click open. iManage inserts the docu-
ment or link at the point of your cursor. You can perform all the usunal functions
from the Integrated Desktop.

Versions

To view a list of document versions, highlight the desired document and right-
mouse click. Select Versions from the pop-up menu.

History

To view the docwment history of a particular document, highlight the desired
document and right-mouse click. Select History from the pop-up menu.

The History dialog displays the activity record for a particular decument in chro-
nological order. The fields displayed in the activity table are User, Application,
Activity, Date-Time, Duration, Pages Printed, Location, and Comments. The
Document History table is not customizable.

The kinds and number of activities recorded for this history is up to your system
administrators but typically include:

+  Opening and closing the document in an integrated application.
+  How long the document was open.

«  Editing the document’s profile. L
+  Changing the access rights of the document.

»  Printing a document and how marny pages were printed.

*  Checking out, copying and/or checking in the document.
*  Viewing the document.
»  Mailing the document through e-mail.

*  Creating a new version of the document

*  The computer {location) where the aclivity took place.

*  Comuments about the activity.

Related Documents

To view related documents, highlight the desired document and right-mouse
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click. Select Related Documents from the pop-up menu.

Document relations are one of the ways you can organize and group documerits,
in addition to folders and document classifications. See Chapter 3 for more infor-
mation about related documents.

Edit Profile

Checkout

Checkin
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To Edit or View a document’s profile information, highlight the desired document
and right-mouse click. Then choose Edit Profile from the pop-up menu.

The Edit Profile dialog box displays the document’s current profile information.
You can edit the information displayed in these fields and then record your
changes. For detailed information on document profiles see Chapter 3: iManage
DeskSite: Basic Functions,

To checkout a document from the Integrated Desktop, select the document(s)
from the Document List and right mouse click. Then choose Checkout from
the pop-up menu.

TUse this Checkout feature when you want to work on a document outside the
Document Management System (i.e. on your local workstation, away from the
network) AND you intend to return the document to the system as the same doc-
ument. The Checkout feature will prevent anyone else from editing the document
while you have it.

To check in a document that is marked checked out, select the document(s) from
the document table and right-mouse click. Then choose Checkin from the pop-
up menu:

The Check In Options dialog box essentially ‘puts back’ a document that you
previously checked out.

This dialog box presents a number of check-in options:

*  Replace Original: The checked in copy of the document replaces the origi-
nal in the database.

*  New Version: The checked in document is added to the database as a new
version of the original document. The original decument remains intact.
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«  New Document: The checked in document is added to the database as anew
document.

+  Keep Checked Qut: The checked in document remains on the local drive.
However vou will no longer be able to check the local copy back into the
database.

»  Delete Local File: The local file is deleted afier adding it to the database.
(This option does not apply if you are checking in portable documents.}

Checkedout Info

If a document is checked out, you can display information about the checked out
document by highlighting the document in the Document Grid and selecting
Checkedout Info from the pop-up menu.

Export

To Export a document, highlight the desired document and right-mouse click.
Select Export from the pop-up menu.

The document export function is essentially the reverse of document importation:
it copies a document from the library to your local hard drive. If you are planning
to edit a document and then return it to the database later, it is advisable to use
iManage DeskSite’s checkout function. See Chapter 3 for more information
about exporting documents.

View

To View a document, highlight the desired document and right-mouse click.
Select View from the pop-up menu.

The View command launches a read-only version of the selected document in the
iManage View application. See Chapter 7 for detailed information on the View
application.

Viewing documents is useful to verify that you have selected the document you
want before you check it out.

Unlock

To Unlock a document from the Integrated Desktop, select the document(s) from
the document table and right mouse click. Then choose Unlock from the pop-up
ment.
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RemoVe from folder

Purge
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About Unlock

If you have suffered a network failure or system malfunction while you were
using documents you may find that those documents are still marked as IN USE.
In such instances, you can use the Unlock feature to tell the system to consider
the document ‘not-in-use’. This allows you or others to checkout the docutnent.

Implications of Unlocking

Any copy of a document that exists locally will be ‘orphaned’ from the network
version after an Unlock is complete. You can only put the local document into
1Manage as a new document. Therefore, you should only use the Unlock option
to free up documents that appear to be in use or checked out, but are erroneously
marked as such due to a network or system fajlure.

Note: You can only unlock documents that are currently marked as IN USE by
you. You cannot unlock documents in use by other users.

The Remove from folder menu option removes selected document(s) from a
particular folder. To delete a document from a folder, highlight the document(s) |
to be deleted and night-mouse click. Then choose Remove from folder from
the pop-up menu.

Note: The Remove from folder menu option does NOT remove a document
from the network or a particular database. Removing a document from the net-
work or database requires a Purge command. Not everyone who has Remove
from folder menu option permissions will have Purge permissions. Contact
your System Administrator for more information.

To purge a document is to remove it entirely from the database.

You purge 2 document from the database by highlighting the desired document in
the Document Grid and selecting Purge from the pop-up memu. Only the author
or operator of a document are allowed to purge a document. This option may also i
be disabled for some users.
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Other Applications

Integration with CompareRite, DocuComp, FullAuthority,
and CiteRite

-Application

The iManage DeskSite program includes a direct interface to the following docu-
ment utilities: CompareRite, DocuComp, FullAuthority, and CiteRite. Compare-
Rite and DocuComp allow you to compare versions of documents with each
other and to produce a report of variations. FuliAuthority and CiteRite are cita-
tion utilities that allow you to analyze the citations that appear in a document.
Access to these utilities is provided in iManage DeskSite by selecting Applica-
tions from the Document menu, then selecting the appropriate application.

Users must have a path established to the directories for these utilities. Each
iManage database automatically provides entries in the application table for each
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of these document ntilities.

E-mail Integration

iManage DeskSite is integrated with electronic-mail products through the MAPT
interface standard. E-mail systems supported include:

+  Network GroupWise
»  Microsoft Mail

«  Microsoft Outlook

*  Lotus cc:Mail

+  Lotus Notes

+  DaVinci

About E-mail Integration
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The iManage DeskSite program includes a user inferface where you can select
documents and mail them through electronic mail.

Using standard drag-and-drop techniques, you can select documents that need to
be mailed from the iManage Desktop window’s Document Grid. Once you have
selected the documents, iManage DeskSite can automatically invoke the e-mail-
send mechanism. iManage DeskSite uses the MAPI standard to display Mail To
windows appropriate to the e-mail system present. When sent via e-mail, docu-
ment profiles have the extension TXT while document filenames have the appli-
cation’s extension—DOC for Word files, WRI for Write files, ete.
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Hurman Resources

Ploase revisw this document.

Figure 5.10: Documents selected for emailing appear as aftachments in your
email application. This screen shot shows how a document appears in Microsoft

Outlook.
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Additional Integrated Functions

Microsoft Word 97 and 2000

Additional integrated functions are available in selected applications. The fol-
lowing additional integrated functions are available in Microsoft Word 97 and
2000. Your system administrator can disable or enable some of these options
selectively.

iManage Mail Merge

When you select iManage Mail Merge from the Tools menu, you can perform
a mail merge using documents from an iManage daiabase as your master docu-
ment and data source document. To perform an iManage Matl Merge, select
iManage Mail Merge from the Tools menu, identify a master document and
data source document, then perform the mail merge. Links to the data source doc-
ument are removed when you close the master document.

Compare iManage Documents

‘When the Compare iManage Documents menu option is enabled by your system
administrator, you can compare the currently open document against a document
in an iManage database by selecting Tools, then Track Changes, then Com-
pare iManage Documents. If this menu option does not appear, then this
option has not been enabled by you iManage Administrator.

iManage Footer

‘When you select the iManage Footer option from the View menu, the follow-
ing information will be inserted in the footer of the currently open document:

Document Name : Document Number — Version Number

If the document name field is empty, only the Document Number and Version
Number will be displayed. Other footer information, such as author name, page
number, file path information, etc., can be inserted automatically using built-in
options in Microsoft Word.
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Overview

This chapter describes some advanced functions available in the iManage
DeskSite program.

= Using CompareRite and DocuComp
»  Using FullAuthority and CiteRite
= Sefting display options

CompareRite, DocuComp, FullAutherity and CiteRite are not provided with
iManage DeskSite.

Other advanced features, such as portable mode and document echoing, are
described in Chapter 7 and Chapter § of this manual.

Using CompareRite and DocuComp

CompareRite and DocuComp are applications that enable you to compare ver-
sions of documents and to produce comparison reports antomatically. For the
CompareRife and DocuComp menu options available in iManage DeskSite to
work properly, these applications must be integrated correctly with iManage
DeskSite.

To compare documents using CompareRite or DocuComp:

1. Highlight the two versions of the document that you want to compare in the

document grid.
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